Microsoft® FrontPage®

Highlights

Introduction

Welcome to the reviewers’ guide for the Microsoft® FrontPage® 98 Web site creation and management tool. This guide will help you understand the design goals of Microsoft FrontPage 98 and provide an overview of the new features. The following topics will be covered in this guide:

- Design goals for Microsoft FrontPage 98
- Product overview
- Site creation and management
- Page creation and design
- Integration of FrontPage 98 with applications, browsers and servers
- Hands-on exercises

For a Web site to be successful, webmasters need the following tools and capabilities that give them the ability to handle the design and maintenance of their site:

- A richly featured and highly usable application to create and manage entire Web sites
- A WYSIWYG editor that allows easy implementation of established and recent HTML features
- A tool to link Web sites to existing databases
- A means of incorporating interactive forms into sites with programming
- An easy way to incorporate scripts, plug-ins, Java™ Applets and ActiveX™ Controls
- A comprehensive tool for planning, organizing, and updating Web sites
- An HTTP server for publishing Web sites on intranets or the Internet
- A fully capable graphics package

FrontPage 98 combines a WYSIWYG editor for creating Web documents with a site management component that provides graphical views of the site in its entirety. FrontPage 98 automates the process of building new Web sites using wizards and provides users with multiple views of their Web site in progress, allowing for the addition of new pages on the fly. The FrontPage Editor works essentially like a high-end word processor, allowing users to lay out pages as they would like them to appear in the browser. With FrontPage, users can easily create Web pages containing advanced features such as Java Applets, ActiveX Controls, Cascading Style Sheets (CSS), database links and fully programmed forms. The newest version of FrontPage even allows users to establish their site as a “channel” that can be “pushed” to
visitors who subscribe to their Web site. Many more features are available in FrontPage 98, and this reviewers guide will address them.

FrontPage 98 includes the Microsoft Personal Web Server 1.5, Microsoft Image Composer 1.5 and Microsoft Internet Explorer 4.0. The Personal Web Server offers users of the Windows® 95 operating system an opportunity to publish their Web sites across the Internet or on a company intranet (users of the Windows NT® operating system have server software built into their operating systems). Image Composer makes creating advanced graphics for Web sites easy; the product is designed from the ground up for webmasters who are not graphics professionals.

FrontPage 98 offers a full suite of tools for Web design and maintenance. These tools are integrated to act as one continuous tool, although they can be invoked separately. Whether you’re a designer of Web pages or the manager of an entire site, FrontPage 98 has a great deal to offer.

**FrontPage 98: A Short History**

Microsoft FrontPage 98 is the most significant upgrade yet to the Web design product that appeared in 1995 as Vermeer FrontPage. FrontPage 1.0 was the first product to combine Web site management and creation into a single, unified tool. Microsoft purchased Vermeer Technologies Inc. and shipped FrontPage 1.1 in the spring of 1996. Microsoft FrontPage 1.1 introduced the familiar Microsoft graphical user interface with the integration features of the Microsoft Office family such as table creation and a spelling checker. Microsoft FrontPage 97 with Bonus Pack, the first version developed completely in-house by Microsoft, brought increased Microsoft Office integration and a suite of Web tools that included Microsoft Image Composer, the Microsoft Personal Web Server and Microsoft Internet Explorer. The power and ease of use offered by FrontPage have made it a favorite among both professional and amateur Web site designers.

Building on this strong heritage, FrontPage 98 is the easy way to create and manage professional-quality Web sites. This latest version of the leading Web tool offers new areas of functionality, enhancements to existing features, and expanded support for the latest Web technologies. The result is a product that lets users easily create great-looking Web sites, effectively manage Web content and site structure, and seamlessly integrate existing content and familiar applications.

**Design Goals for FrontPage 98**

The feature set of FrontPage 98 is a direct result of customer feedback and, given the broad set of users of FrontPage, spans a wide range of customer needs. Three broad themes emerged from the research and design phase of the development process for FrontPage 98:

- **Ease of use.** Regardless of their technical sophistication, customers want easy-to-use tools that help them get their jobs done. New Web authors expect the ease of word processors while power users demand HTML editing and straightforward methods to incorporate Java, ActiveX technologies, and other leading-edge Web features into their sites. Completely new WYSIWYG tables
and frames support, automatic generation of Navigation Bars, a redesigned
Getting Started tutorial, and open support for the latest Web technologies are just
a few examples of the improvements in ease of use in FrontPage 98.

- **Intelligent design assistance.** The number of Internet and intranet Web
  sites continues to grow rapidly. The ability to build great-looking, professional
  Web sites that cut through the clutter has moved to center stage with customers.
  More than 50 professionally designed graphical themes, prebuilt Java Applets
  and ActiveX Controls, a user-friendly implementation of Dynamic HTML, a new
  set of image editing tools, and a new version of Microsoft Image Composer are
  included in FrontPage 98 to help users create the most interesting and compelling
  sites on the World Wide Web.

- **Expanded site management.** Users no longer confine their Web software
  evaluation criteria to simple page-creation features. Web sites are live entities —
  the number of pages grows, hyperlinks break, and content goes stale.
  Consequently, site management has quickly moved from an afterthought to a
  requirement. FrontPage 98 addresses this paradigm shift by delivering an even
  more comprehensive set of features that truly helps users effectively plan,
  organize, update and maintain their sites. A completely redesigned FrontPage
  Explorer interface, several new Explorer views, and support for automatically
  generating and updating Navigation Bars represent some of the site management
  enhancements in FrontPage 98.

**Product Overview**

FrontPage 98 makes it possible for all users to create rich, compelling Web sites.
New Web authors familiar with word processors will find the FrontPage interface
easy to use. Sophisticated Web professionals seeking full support of the “best of the
Web” technologies will find that support in FrontPage 98.

**Create Professional Web Sites without Programming**

Intuitive, leading-edge features help users create professional Web sites, without
programming. New features and improved functionality make it easier than ever for
new users to get up and running quickly. Feature refinements in FrontPage 98 help
make simple tasks automatic and complex tasks easier.

- **Improved Getting Started dialog box.** A simpler Getting Started dialog
  box makes it easier to get results. FrontPage 98 also includes a default Web site
  that provides a starting point for beginning users to get up and running on their
  Web sites quickly. Similar to the Most Recently Used list in other Microsoft
  applications such as Microsoft Office, FrontPage 98 lets users easily open any of
  their most recently used Web sites without ever having to type in a URL.

- **Navigation Bars.** Automatically generated Navigation Bars on Web pages
  can be included with a few mouse clicks. FrontPage 98 lets users specify the
  levels and hyperlink styles they want to include for defining a consistent
  navigational structure for their site. Navigation Bars are automatically
  regenerated any time the user changes the structure of a site. FrontPage 98 is the
only Web creation and management tool available that builds and updates Navigation Bars in native HTML environment.

- **Pervasive drag-and-drop WYSIWYG FrontPage Editor now with new Views tabs.** Easy to discover and easy to use, the FrontPage 98 Editor features new tabs at the bottom of the screen so users can quickly toggle between several views of their Web page, such as the improved and editable HTML view, the Preview view, and the Normal view.

- **Enhanced table creation and editing.** Layout of Web pages can be designed more quickly and easily than ever with the pixel-level precision of the new table-drawing tools. With the on-screen equivalent of a pencil and an eraser, users can create tables of any size or shape directly on their Web page. With the table-drawing tools, users have the flexibility to design the layout of a page precisely by fitting a table to their content. Images, text, multimedia files, even tables nested within tables can be included in a table. FrontPage 98 also gives users visual control of the structure and layout of table rows and columns. Drag-and-drop functionality enables users to move or copy table rows and columns. Resizing rows and columns is as easy as selecting a border with a mouse and moving it to the desired location. The new Distribute Rows Evenly and Distribute Columns Evenly commands space rows and columns evenly with a click of the mouse.

- **WYSIWYG frames.** Frame sets can be created and modified directly within the FrontPage Editor in a truly WYSIWYG fashion. Users can choose to create frames from templates provided or create a custom frames grid with a few clicks of the mouse. Then the pages and frame set can be edited directly on the screen. Creating and editing frames just as they’ll appear in the browser is now remarkably simple.

- **FrontPage components.** Formerly referred to as WebBot™ components, these precompiled CGI scripts let even novice users add powerful interactive functionality to their Web sites. A component can simply be dropped onto a Web page to generate full text searches, discussion groups, forms and more.

New component support in FrontPage 98 includes the following:

*New Form Save Results to E-mail component.* This feature lets users specify an e-mail address to which completed forms should be sent. Now users of FrontPage 98 can save results to a database, text file or e-mail.

*New Hit Counter component.* No programming is required to keep track of how many hits a Web page receives. Users of FrontPage 98 may insert the Hit Counter component with a simple menu command and easily reset the number displayed as well as the style in which it is displayed.

*Improved Save Results component.* Setting up the handling of forms results is easier than ever with the improved Save Results component. An intuitive and streamlined user interface gives users more power and control to determine how their results are handled.
Easier importing of existing Web sites. The improved Import Wizard makes it easier than ever to import existing Web sites into FrontPage. Even if a user has created a site without using FrontPage, he or she can take advantage of the powerful editing and management capabilities in FrontPage in the ongoing deployment of his or her Web site. The new wizard supports importing from a URL as well as from a file directory. Users can also limit how much data they import by designating a specific number of link levels or kilobytes of data. Users may also choose to import text and images only.

- **Automatic estimated time to download.** FrontPage 98 automatically estimates the time required to download the current page being edited, a very helpful quality-assurance feature.

- **Easier creation of hyperlinks.** The Hyperlinks dialog box has been completely redesigned in FrontPage 98 for dramatically enhanced ease of use. The new dialog box makes it even easier to link to new pages, existing pages in the site, existing pages on the Internet, or directly to e-mail addresses. Users of FrontPage 98 will also find it easier to link to bookmarks and specify link targets when using frame sets.

- **New templates and wizards.** Templates and wizards make it easy for users to create content as well as entire Web sites. Now FrontPage has more of these to help make the complex easier and the easy automatic.

- **Improved documentation.** By making online Help more complete, significantly enhancing the manual Getting Started to include the FrontPage Server Extensions, and providing a direct link to the FrontPage Web site through the Late Breaking News menu item, users of FrontPage 98 will have access to a wealth of information that will make it easier for them to get up and running as well as take advantage of more advanced functionality in the product.

Intelligent Design Assistance

Intelligent design assistance and innovative imaging tools make it easier than ever to build great-looking Web sites. One of the key design goals for FrontPage 98 was to build into the product all the tools and features needed to help any user create rich, dynamic Web sites without requiring the services of a graphic designer.

- **FrontPage themes.** Users can create a great-looking Web site quickly with more than 50 professionally designed themes that can be applied to an entire site or to individual pages. Backgrounds, bullets, banners, hyperlinks and Navigation Bars come together to deliver a great-looking and consistent appearance, all without the need for a graphic designer.

- **Image Composer 1.5.** The latest version includes the Microsoft GIF Animator and is optimized for creating and editing images for on-screen delivery. With Image Composer 1.5, users have a high-powered image-composition and editing tool that lets them create professional-quality graphics and images for their Web sites.
**Improved image-editing tools.** New image-editing tools in the FrontPage 98 Editor make it easy for users to bevel, crop, flip, rotate or “wash out” images. Page download times can be significantly reduced by using the new Resample button. The Resample button automatically recasts images that have been resized from large to small. Useful for any image, these tools are particularly well-suited for images scanned in directly from digital cameras or scanners with FrontPage 98 TWAIN support. FrontPage 98 also lets users resample a large image, which shrinks the physical image to reduce its download time.

**Shared Borders.** The new Shared Borders feature lets users specify shared, or common, headers or footers (horizontal or vertical) across the pages in their Web sites. Shared Borders provides a great deal of design flexibility in creating a great-looking, and consistently designed, Web site.

**Hover buttons.** Hover buttons bring life to Web pages. When visitors to a site “hover” over the button or click it, the button will change colors or shape, or animate any way the author using FrontPage 98 has chosen. Hover buttons are actually small Java Applets that FrontPage 98 creates automatically, so no programming knowledge by the user is required.

**Banner Ad Manager.** The Banner Ad Manager makes Web pages come alive by displaying a rotating series of graphics with transition effects between them. This feature lets users save screen “real estate” by rotating multiple messages or images in the same space on a Web page. The Banner Ad Manager is another example of a FrontPage component, so no programming is required to achieve professional-quality results.

**Auto Thumbnail.** A small thumbnail image of a graphic can be automatically created and linked to the larger original image from which it was created. Auto Thumbnail is great for creating picture galleries on the Web.

**Graphical bulleted lists.** FrontPage lets Web authors specify custom images to use as bullets in place of the plain bullets normally found on Web pages. The FrontPage Editor lets users edit these graphical bulleted lists just as easily as they would a bulleted-text list. When users apply a FrontPage theme, matching graphical bullets are automatically applied to existing or newly created bulleted lists.

**Resizing of images.** Any image can be resized within the FrontPage Editor.

**Fonts.** FrontPage 98 supports all TrueType fonts.

**ClipArt.** FrontPage 98 sports the same Clip Gallery interface as Microsoft Office and Microsoft Publisher, so users can easily preview and insert clip art through the familiar interface. And if Office or Publisher clip art is installed, users have seamless access to that clip art as well. FrontPage 98 will ship with more than 1,000 clip-art images. From within the Clip Gallery, dialog box users can download thousands of clip-art images directly from the Microsoft Web site. These images are automatically added to the Clip Gallery for easy access the next time a user needs them.

**Text overlay on images.** FrontPage 98 lets Web authors add text directly onto their images. Creating page elements such as graphical buttons is now easier than ever.
Native TWAIN and digital camera support. Built-in TWAIN support means users of FrontPage 98 can scan images directly into FrontPage from their scanner or digital camera. This makes it much easier to add personal photographs or existing company product and service photographs to a site.

Support for the latest Web technologies

FrontPage 98 provides flexible, open support for the latest Web technologies, giving users the power to create compelling, original sites on the World Wide Web. Sophisticated users seeking support for the “best of the Web” technologies have never been disappointed with FrontPage. FrontPage 98 offers support for the latest Web advancements, including the leading-edge functionality offered by Microsoft Internet Explorer 4.0.

Improved HTML editing. FrontPage 98 preserves more of the user’s hand-formatted HTML source code and includes better automatic formatting of algorithms to make the generated HTML code easier to read. In addition, the editable HTML view has moved from a menu-driven dialog box to a tab view in the FrontPage 98 Editor. The new view makes it easier for users to quickly access and manually edit their HTML source code, just as they would in any code or text editor.

Support for Java Applets and ActiveX Controls. By supporting Java Applets and being a container for ActiveX Controls, FrontPage 98 gives users the ability to develop powerful Web applications in an intuitive WYSIWYG environment.

Browser plug-in support. By supporting plug-ins, FrontPage makes it possible for users to easily incorporate dynamic Web content into their Web pages.

Database access. FrontPage 98 includes the new Active Server Page (ASP) Database Region Wizard, which walks users through the process of creating Web pages that incorporate live, dynamic database queries. FrontPage 98 also supports access to any ODBC-compliant database, allowing users to perform dynamic database queries over the Web.

Support for Dynamic HTML. Dynamic HTML is a new Web page object model specification developed by Microsoft and submitted to the World Wide Web Consortium for approval. The Dynamic HTML specification allows programmers to manipulate Web pages and their elements in exciting and powerful ways. Because the mission of FrontPage is to provide the ability to create professional-quality Web sites without programming, FrontPage 98 has a range of features that lets users take advantage of the benefits of Dynamic HTML without having to program the Dynamic HTML object model themselves.

Text animations. Users can easily create text animations such as text flying in from off-screen or words that are revealed letter by letter. They can also easily apply animation effects to their Web pages that one would previously expect to find only in presentation applications such as the PowerPoint® presentation graphics program.
**Form field extensions.** An accessibility feature, this gives all users the ability to access Web page form fields quickly with the keyboard by defining the tab order and “Alt+” key shortcuts for all form fields.

**Dynamic outlining.** Users can create expanding and collapsing outlines in a Web page without programming. Previously, this required sophisticated scripting, ActiveX Controls or Java programming but can now be created using a simple FrontPage dialog box.

**Page transitions.** Users of FrontPage 98 may choose from a variety of different page transitions (dissolve, wash away, etc.), so visitors using Microsoft Internet Explorer 4.0 to browse their site can experience stunning visual effects when navigating between pages. The effects are similar to what is available in presentation packages such as PowerPoint.

**The Channel Definition Wizard.** Users of FrontPage can take advantage of the exciting new world of push technology. With the Channel Definition Wizard, users can quickly turn Web sites into a channel to which visitors can subscribe for automatic content delivery to any desktop running Microsoft Internet Explorer 4.0.

**Cascading Style Sheets support (CSS).** Cascading Style Sheets are an open specification endorsed by the World Wide Web Consortium that gives Web authors word processor-like control over the text in HTML documents so they can define complex styles for Web elements such as paragraphs, documents and collections of documents. Web authors can create extensive and dramatic page layout settings. FrontPage 98 supports 100 percent “round tripping” of all CSS attributes and also provides an interface for setting CSS properties. Popular Web browsers supporting CSS include Microsoft Internet Explorer 3.0 and higher and Netscape Navigator 4.0.

**Visual Basic Scripting Edition and JavaScript support.** With support for the Visual Basic® programming system Scripting Edition and JavaScript authoring, users can create rich custom solutions with FrontPage by using an easy dialog box-based user interface.

**Secure sockets layer (SSL) support.** SSL provides users of FrontPage with higher levels of security when communicating between the client and the server, due to stronger encryption and authentication technology. (SSL is supported but not included in FrontPage 98.)

**Improved Active Server Page (ASP) interoperability.** FrontPage 98 manages hyperlinks found within ASP script code. Furthermore, Web pages containing ASP code can now be edited with greater fidelity using the FrontPage 98 Editor.

**Design Time ActiveX Controls.** Design Time ActiveX Controls are a new type of component that let third parties extend the Web-creation capabilities of FrontPage 98.

Effective Management of Web Content and Site Structure
Individual Web authors, as well as teams of authors and contributors, can build and maintain well-organized sites with FrontPage 98. And users will never have to worry about broken hyperlinks again.

**Innovative Site Management Tools**

Comprehensive management tools let users quickly plan and organize their site. FrontPage 98 improves upon the leading site management features found in FrontPage 97. A redesigned FrontPage Explorer interface combines with additional site views to give users complete control over their site. Maintaining a site and updating it with fresh content has never been easier.

**New Views Bar.** The FrontPage 98 Explorer features a new Views Bar along the left side that gives users one-click access to all the FrontPage views, including the new Navigation, All Files and Themes views. Similar in style to the Outlook™ Bar found in the Microsoft Outlook desktop information manager, the FrontPage Views Bar also includes other site management views such as Folders, Hyperlink, Hyperlink Status (formerly Verify Hyperlinks) and Tasks (formerly To Do List).

**Navigation View.** Navigation View is an innovative site creation and management feature that lets users create and manage the navigational structure of their Web sites within seconds. It’s easy to connect new pages and move pages around. As changes are made, FrontPage 98 automatically generates the appropriate Navigation Bars on each Web page. Users can rotate as well as size to fit the Navigation View on their screen. The Navigation View, like every other view in FrontPage, generates Web sites in native HTML. Because FrontPage does not employ proprietary file formats, users can, at any time, view and edit the HTML or collaborate with others in a multiuser environment. Generating native HTML also eliminates the need to maintain two sets of code per Web site (one proprietary and one HTML).

*Print Navigation View Site Maps.* FrontPage 98 lets users print out the graphical structure of their Web sites directly from the Navigation View in the FrontPage Explorer. No longer will users spend endless hours at whiteboards or scratch paper as they diagram the layout of their site.

**Folder View.** The Folder View lets users organize their Web content the same way they organize files on their desktop, by creating folders and subfolders. Content can be moved easily from one folder to another with drag-and-drop functionality; FrontPage 98 will automatically rename files and update all associated hyperlinks.

**Hyperlink View.** The Hyperlink View gives users a graphical representation of the physical layout of their Web sites. Users can expand and collapse individual pages to trace hyperlinks throughout a site and see instantly if any hyperlinks are broken.

**Hyperlink Status View.** This new view in FrontPage 98 presents users with a “snapshot” of all the hyperlinks, both internal and external, in a Web site. Now
users have a centralized dialog box to check the status of hyperlinks and make necessary repairs.

**All Files View.** The FrontPage Explorer includes a new All Files View that makes it easy to take inventory of all the files in a given site in a single flat view. This makes it easy to sort files to find duplicates, to find very large files, or to find files that have changed recently.

**Manage orphan files.** The FrontPage 98 Explorer All Files View also features a way to easily arrange and sort “orphan” files (files without any links pointing to them) so users can more easily manage these files and keep the size of their Web site to a minimum.

**Improved Hyperlink Functionality**

The automatic hyperlink maintenance in FrontPage 98 gives users the freedom to manage their site without worrying about broken hyperlinks. Maintaining the integrity of the Web site is a primary concern. FrontPage 98 improves on the leading hyperlink functionality introduced in FrontPage 97. Now users can enjoy expanded, more easily discoverable hyperlink maintenance with drag-and-drop ease.

**Automatic hyperlink updates.** FrontPage 98 lets users rename files and drag and drop assets to other pages or folders. FrontPage automatically renames the modified files and updates any related hyperlinks.

**Ability to view and manage native Office 97 files.** Users of FrontPage 98 may rely on the FrontPage Explorer to manage hyperlinks in their Word 97, Microsoft Excel 97 and PowerPoint 97-based files. All the site management features, including the hyperlink maintenance tools, can be used in conjunction with Office 97 files.

**Ease of Updating Content**

FrontPage 98 helps users quickly and easily update their entire Web site. FrontPage 98 includes a number of new features to help keep Web sites from going stale. Creating and maintaining fresh, up-to-date content is an effortless process with FrontPage 98.

**FrontPage themes.** FrontPage 98 makes it possible to update the look of an entire Web site simply by modifying the site’s existing theme or selecting a new theme and applying it across the site. FrontPage 98 ships with more than 50 professionally designed themes.

**Cross-Web find and replace.** Users can quickly update text throughout their sites by performing a global find and replace.

**Cross-Web spelling checker.** FrontPage 98 includes a spelling checker to improve the accuracy of the content.

**Thesaurus.** FrontPage includes a thesaurus to assist users in creating and updating the wording on their site.

**One-button publishing.** The FrontPage 98 Web publishing interface has been dramatically simplified and now supports one-button publishing to a Web server
from the FrontPage Editor toolbar. FrontPage 98 offers incremental publishing — only new pages and files that have changed since the last time material was published will be uploaded to the Web server. In addition, FrontPage 98 will automatically detect changes made by others in a multiuser environment and gives the site owner the ability to resolve conflicts among different users. Finally, users in need of a Web presence provider (WPP) to host their Web site can click a button to see an up-to-date list of registered FrontPage WPPs.

**Web Publishing Wizard.** The new version of this wizard is designed for users who publish their sites to servers that do not contain the FrontPage Server Extensions. Web Publishing Wizard version 1.5 takes advantage of the FrontPage 98 one-button publishing feature and is smart enough to forestall the most common errors that can occur when publishing a Web site to the world using alternate publishing methods such as FTP or through America Online.

**Flexible Collaboration Features**

Regardless of where users and their colleagues are located — across the hall or on the other side of the globe — FrontPage helps a team stay on track in the ongoing process of creating, managing and updating its Web site.

**Tasks View.** This new view was formerly referred to as the To Do List in FrontPage 97. In FrontPage 98 this functionality has been elevated to the FrontPage Explorer views level. The Tasks View is a central repository that tracks the status — owner, completion status, comments, date due, etc. — of each Web page.

**Multiauthor support.** FrontPage was the first to implement multiauthoring capabilities and is still the only product in this category to deliver this functionality. Just as multiple users can browse the same site using Microsoft Internet Explorer, multiple users may author the same site using FrontPage. Teams of people can contribute content to the same Web site simultaneously; FrontPage warns users about potential file conflicts. To set authoring permissions in FrontPage, select Tools, Permissions in the FrontPage Explorer.

**Support for local and remote authoring and administration.** FrontPage 98 provides authoring and administration support in a client/server environment. Users hosting their Web sites remotely may publish them via standard HTTP protocol, as well as remotely administer Web settings such as permissions. All server administrator functions in FrontPage are now exposed remotely via HTML forms.

**Personal Web Server (PWS).** FrontPage 98 includes the Microsoft Personal Web Server to give users a robust Web server on which to test, stage and host their sites. The PWS is a Windows 95 port of the popular Microsoft Internet Information Server (IIS), which runs on the Windows NT Server network operating system.

**Flexible permissions.** FrontPage 98 lets users control access to Web content. Web owners may grant different levels of access to different sets of users — authors, administrators and general end users (browsers).
Integration with Microsoft Visual SourceSafe. FrontPage 98 includes the necessary “hooks” to provide full integration with the Visual SourceSafe version control system. Users of FrontPage 98 requiring advanced security and version control over Web site content can turn to Visual SourceSafe to provide file check-in and check-out services.

Seamless Integration of Existing Content and Familiar Applications
FrontPage 98 helps users get more out of what they already have. They can save time, effort and money by integrating FrontPage 98 with existing desktop and server software.

Tight Integration with Microsoft Office
FrontPage 98 is the only Web site creation and management tool that is a member of the Microsoft Office family. Building upon what users and their organizations already know will help shorten learning curves and save on training and support costs.

  Consistent interface. FrontPage looks and acts just like the familiar Office family of products. New Web authors will get up and running quickly in this familiar environment.

  Shared tools. Common files such as ClipArt, spell checker, find and replace, and thesaurus save disk space. FrontPage 98 sports the same Clip Gallery interface as Microsoft Office and Microsoft Publisher so users can easily preview and insert clip art through the familiar Clip Gallery interface. Further, if Office or Publisher clip art is installed, users have seamless access to this clip art as well.

  Office file converters. Users can incorporate Office 97 files in their native format or, if preferred, convert existing files to HTML on the fly. In addition, FrontPage can automatically convert all popular word processing and spreadsheet file formats to HTML.

FrontPage and Office Together are Easy Tools for Building an Intranet Quickly
Small workgroups and large departments alike will find FrontPage and Office to be easy-to-use and effective tools to get intranets up and running quickly. The Microsoft Personal Web Server, included in FrontPage 98, as well as tight integration with Microsoft Windows NT and Internet Information Server, reduces the complexity of hosting intranets created with FrontPage.

  Cross-platform support. FrontPage and Office are tightly integrated on all the desktop platforms: Windows 95, Windows NT Workstation and Macintosh. Now, all users in an organization can contribute content or manage intranet sites with tools already familiar to them.

  The Microsoft Office 60 Minute Intranet Kit. This free kit (available from the Microsoft Office Web site; connect-time charges may apply) provides advice, tools and templates to help intranet authors use Office and FrontPage to get their intranets up and running quickly.
Compatibility with the Most Popular Web Browsers

FrontPage 98 supports all the latest HTML tags and can easily be configured to install itself as the default HTML editor with Microsoft Internet Explorer 4.0. FrontPage 98 supports many of the groundbreaking features found in Microsoft Internet Explorer 4.0, including channel definition format, Cascading Style Sheets, and Dynamic HTML. FrontPage 98 provides wizards and dialog boxes to step users through the process of incorporating these features into their Web sites, so absolutely no programming is required. Finally, the Microsoft Internet Explorer 4.0 HTML Editor and the FrontPage 98 Editor share the same interface. Novice users who create their first Web pages with the Microsoft Internet Explorer 4.0 HTML Editor will find FrontPage 98 to be a logical choice as their needs move beyond single-page editing to full Web site creation and management.

Compatibility with and Acceptance of FrontPage Server Extensions

Cross-platform server support ensures broad compatibility with and wide acceptance of the FrontPage Server Extensions. The FrontPage 98 Server Extensions run on all popular UNIX, Windows 95 and Windows NT-based Web servers. The extensions support many of the interactive features that FrontPage offers, such as text searches, forms and discussion groups. They also make possible remote authoring and administration. An ongoing commitment to offer support for all popular Web servers, regardless of platform, means that users can easily find a place to host their Web sites created with FrontPage. All major Internet service providers (ISPs), as well as hundreds of regional ISPs, are registered FrontPage Web presence providers, so small and medium-sized businesses can readily find a provider to host their sites. Corporate customers looking to create an intranet can host their sites on an existing UNIX or Windows NT-based Web server.

Expanded documentation. FrontPage 98 includes the new Server Extension Resource Kit (SERK). The SERK provides detailed instructions and advice for Web server administrators responsible for the installation and configuration of the FrontPage 98 Server Extensions.

Easier installation and configuration. The FrontPage 98 Server Extensions include new integrated scripts for fast, accurate installation of the FrontPage Server Extensions on UNIX Web servers.

Remote Web server administration. The FrontPage 98 Server Extensions support HTML-based remote administration. Now Web server administrators can more easily administer their Web servers regardless of location and more effectively manage large numbers of servers.

Expanded support for recently released UNIX and Windows NT-based Web servers. FrontPage 98 Server Extensions will include support for Apache 1.2 and Netscape Enterprise 3.0 UNIX Web servers, as well as Netscape Enterprise 3.0 and Microsoft IIS 4.0 Web servers for Windows NT.

Zero-delta ship for UNIX Server Extensions. The FrontPage 98 Server Extensions are scheduled to ship as included elements of the FrontPage 98 client.
The UNIX Server Extensions will be available on both the FrontPage Web site and the FrontPage 98 client CD.

Integration with Microsoft Windows NT Server

FrontPage 98 integrates more tightly with Windows NT Server than any other Web site creation and management tool, providing an easy gateway to the Microsoft family of Internet products.

Tighter integration with Microsoft IIS. The FrontPage 98 Server Extensions for IIS are native Internet Server API (ISAPI) dynamic-link libraries (DLLs) and offer improved performance over common gateway interface (CGI) extensions. The extensions become an integral part of IIS starting with the release of IIS 4.0, where they are integrated into the setup as well as the administration tools.

Improved support for Microsoft Index Server. If installed, FrontPage 98 uses Index Server as the default search engine, which means not only are HTML documents indexed, but all Office documents and flat text files are as well. FrontPage 98 Index Server enhancements make it easy for Web site administrators of FrontPage authors to customize their search forms, and the setup of multihosted servers with the Index Server (and the FrontPage Search Component) has been made automatic.

Database Region Wizard. FrontPage 98 offers users easier access to data. The Database Region Wizard walks users through the process of creating dynamic, ASP, live database links.

Improved Active Server Page interoperability. Web pages containing ASP code can now be edited with greater fidelity using the FrontPage 98 Editor.

Design Time ActiveX Controls. Design Time ActiveX Controls are a new type of component that lets third parties extend the Web site creation capabilities of FrontPage 98. Similar to FrontPage components, Design Time ActiveX Controls provide a friendly user interface over script code or other complex HTML constructs, but with the added benefit of being usable in both the FrontPage Editor and the Visual InterDev™ Web development system editing environments.

Microsoft Commercial Internet Services (MCIS) integration. Membership is a feature of the MCIS used by ISPs. Many WPPs offer membership services to their FrontPage-based Web site hosting customers. Users of FrontPage 98 benefit from this integration through increased security and a single logon to all their ISP’s services.

Improved integration with the IIS 4.0 administration tool. The IIS 4.0 administration tool includes support to add the FrontPage Server Extensions to an IIS 4.0 Web server with a single checkbox. No separate tools are required.

Command-line automation tools. IIS 2.0 and 3.0 server administrators will benefit from a new set of tools and scripts that make it possible to automate repetitive administrative tasks via command-line scripts.
**Integration with Microsoft Visual InterDev.** Visual InterDev and FrontPage share the same HTML Editor. Using the products together provides organizations with the broadest possible set of tools to create complex Web sites. Developers will find Visual InterDev to be a powerful Web application tool, while end users will find FrontPage to be an easy-to-use content creation and management tool.

**Integration with Visual SourceSafe.** Users of FrontPage requiring advanced security and version control over Web content can turn to Visual SourceSafe to provide check-in and check-out services. FrontPage includes the necessary “hooks” to provide support for integration with Visual SourceSafe.

**Site Creation and Management**

Strong site management lies at the heart of all successful Web sites, and it is correspondingly at the heart of FrontPage 98. Using FrontPage Explorer, webmasters can manage the development of a site’s individual elements, upgrade a site as new information is required, and monitor all internal and external links to ensure that the site works from a technical standpoint. Nothing is more frustrating to a Web site visitor than clicking on a broken link, and FrontPage Explorer helps Web site administrators find and eliminate these kinds of problems. But until a site is in place, and operating in conjunction with a Web server, management can’t take place at all, and the FrontPage Explorer takes care of this aspect as well. Through the FrontPage Explorer, webmasters can begin the creation of a site, using the built-in set of templates and wizards, and control the development of the site by assigning permissions to administrators and authors.

FrontPage 98 makes all these tasks easier than before through a new interface that focuses on various views of a Web site. Seven views are now available to the webmaster, each of which offers a specific type of look at the site. Within these views, the site can be managed, pages can be added or deleted, and hyperlinks can be verified and updated. The FrontPage Explorer also provides creative control over the site as a whole, with automatic creation of Navigation Bars, the application of graphical themes, and the addition of shared borders among all pages. Also through the FrontPage Explorer, part or all of a Web site can be developed as a channel to which site visitors can subscribe.

Much of a webmaster’s time will be spent within Explorer, except when producing and laying out individual pages. Explorer provides users with the ability to keep constant tabs on their sites and even on the personnel who are helping to produce them.

**The FrontPage Explorer Environment**

FrontPage Explorer displays Web sites. Besides the menus and toolbars, the Explorer screen consists of two essential regions — the main window and the Views toolbar. The basic screen is shown in Figure 1:
The Views toolbar on the left offers single-click access to several different perspectives on a site. Each of these perspectives is called a view. The main window changes with each view. In the All Files View above, the main window consists of only one pane. In other views, the main window is divided into two panes, in either a vertical or horizontal configuration. Each of these views is presented in detail.

At the top of the screen are the menus and toolbar. While the toolbar largely reflects the Edit menu, learning the other menus in FrontPage Explorer is essential for using the program’s full capabilities. The File menu contains commands for importing and exporting pages and entire sites and for publishing sites to servers without FrontPage extensions. Even more crucial to site management is the Tools menu, where most of the action takes place. This menu allows users to establish settings and permissions for their site, confirm and correct hyperlinks, define shared borders among pages and create a channel for serving up their site via push technology. The Tools menu is shown in Figure 2:

**Figure 1**

The Views toolbar on the left offers single-click access to several different perspectives on a site. Each of these perspectives is called a view. The main window changes with each view. In the All Files View above, the main window consists of only one pane. In other views, the main window is divided into two panes, in either a vertical or horizontal configuration. Each of these views is presented in detail.

At the top of the screen are the menus and toolbar. While the toolbar largely reflects the Edit menu, learning the other menus in FrontPage Explorer is essential for using the program’s full capabilities. The File menu contains commands for importing and exporting pages and entire sites and for publishing sites to servers without FrontPage extensions. Even more crucial to site management is the Tools menu, where most of the action takes place. This menu allows users to establish settings and permissions for their site, confirm and correct hyperlinks, define shared borders among pages and create a channel for serving up their site via push technology. The Tools menu is shown in Figure 2:

**Figure 2**

The Views

**Navigation View**
The Navigation View is the newest addition to FrontPage, and it is the default view whenever a new site is created. The Navigation View provides a work space that mirrors a real-world whiteboard, where site designs are displayed graphically and hierarchically, and where experimentation is simply a matter of adding, erasing or rearranging components. It’s easy to connect new pages and move pages around. As changes are made, FrontPage 98 automatically generates the appropriate Navigation Bars on each Web page. You can rotate as well as size to fit the Navigation View on their screen. The Navigation View, like every other view in FrontPage, generates Web sites in native HTML. Because FrontPage does not employ proprietary file formats, users can, at any time, view and edit the HTML or collaborate with others in a multiuser environment. Generating native HTML also eliminates the need to maintain two sets of code per Web site (one proprietary and one HTML).

**Print Navigation View Site Maps.** FrontPage 98 lets you print out the graphical structure of their Web sites directly from the Navigation View in the FrontPage Explorer. No longer will you have to spend endless hours at whiteboards or using scratch paper as you diagram the layout of your site.

Figure 3 shows the Navigation View for a site:

![Figure 3](image)

**Figure 3**

The site itself is displayed in two regions: the main window and the contents window. The main window shows the site as a set of pages, each of which conforms to a document file in that site’s folder. Each corresponding file can be located in the contents window and in other Explorer views.

The purpose of the main window in Navigation View is to show you how the files are related from the standpoint of navigating through the site. Lines show the hierarchical organization of the pages, and the view can be expanded or collapsed as needed by clicking the plus (+) or minus (-) signs atop the icons.

But the Navigation View does more than just display your site. You can create new pages and link them to existing pages quickly and easily from this single view. Right-clicking on the icon for an existing page yields a menu that includes the New
Page item. Once the new page is completed, you can name it whatever you wish and you can also detach it from the current icon and attach it to another instead. In this way, you can arrange and rearrange your site in countless ways.

You can also add pages to your site in Navigation View by dragging files from the contents window and dropping them in place in the main window. In this way, you can in effect reuse pages you’ve already created, by first copying them into the existing site (using Windows Explorer rather than FrontPage Explorer) and then dragging them onto the Navigation View.

Hyperlink View

The Hyperlink View remains unchanged from FrontPage 97, but it remains a crucial component of the package. Hyperlink View provides a graphical representation of a complete Web site and its links to remote locations. The left pane of the main window, called All Pages, shows a directory tree with icons for each page. To view graphical representations of the image links, click the Hyperlinks to Images button on the toolbar, or (new to FrontPage 98) right-click in the Hyperlinks frame (the right-hand frame).

Figure 4

The right pane of Hyperlink View displays the site with arrows showing how pages are linked and in which direction(s). Links to remote locations show up as pages with a superimposed globe, and broken links display, naturally, as broken arrows. When you click an item in the left-hand pane of the Hyperlink View, the display in the right pane immediately focuses on that page and its links; in this way, you can keep alternating between pages, checking the precise structure of the site.

When you hover the cursor above an icon in the Hyperlinks frame, for example, Explorer displays the associated .HTM file and the type of link that icon represents (primarily internal or external). As you hover, the arrow to the icon changes color to red, helping you see exactly how the links are constituted. You can further adjust the display by right-clicking in the right-hand pane and selecting Repeated Hyperlinks or
Hyperlinks Inside Page. By selecting these as well as Hyperlinks to Images, you have a visual representation of all links in your site.

As with Navigation View, you can delete pages from within Hyperlink View, and if you want to edit one of the items, you can double-click it. If it’s an .HTM file, it will load into FrontPage Explorer; any other file will load into the application Windows has associated with that file type.

**Themes View**

A new feature of FrontPage 98 is the Themes View. By selecting a theme, you give the entire site a consistent design appearance. Each page shares a common background pattern, button styles, bullet types and font choices. At any point during your Web design, you can change the theme, and the entire site will be updated to reflect this new choice. If you combine a theme choice with the Shared Borders feature (also available in Explorer), you can automatically create navigation buttons (which are small Java Applets) that will be consistent across all the pages of your Web site. You can also select themes for individual pages from within FrontPage Editor, but as a starting point for design, the Themes dialog box in FrontPage Explorer is difficult to beat.

The FrontPage Software Development Kit (SDK) will include a utility called Themes Designer. The Themes Designer will provide an easy, graphical interface for editing the Themes that ship with FrontPage. After installing the Themes Designer from the SDK, a menu option will appear on your FrontPage Editor Tools menu to provide easy access to the Themes Designer.

![Themes - FrontPagers](image)

**Figure 5**

**Folders View**

The Folders View in FrontPage Explorer is essentially the same as the view of your hard drive provided with Windows Explorer. The left pane (“All Folders”) shows the folders for the current site, while the right pane (“Contents”) shows the files and
subfolders. You can drag folders from one folder to another, and FrontPage Explorer will rename the file and all references to it in the site. You can also copy and delete files from within this view.

Figure 6

All Files View

The All Files View is extremely useful for Web site management. Here are displayed the names of all files within the currently loaded site, their page titles and the folder in which they reside. This view is very useful for weeding out duplicate files. You also see the type, size and modification date of all files. The All Files View provides the ability to easily arrange and sort “orphan” files (files without any links pointing to them) so users can more easily manage these files and keep the size of their Web site to a minimum.

The difference between the All Files View and the Folders View is that the All Files View is focused on files, helping you see all of them at once; the Folders View relies on the more traditional depiction of sorting by folders.
One of the difficulties in designing Web sites lies in keeping track of all the hyperlinks on the various site documents. The Hyperlink Status View shows each internal and external hyperlink, associating it with the page on which it is found and the title of that page. Double-clicking a hyperlink brings up the Edit Hyperlink dialog box, where you can replace that hyperlink with another of your choosing, on any or all pages on which that hyperlink exists. This view keeps track of links within your site and external to it, and when combined with the Verify Hyperlinks and Recalculate Hyperlinks commands of the Tools menu, acts essentially as an assistant manager for you in determining a fully functioning site.

Tasks View

Another new feature of FrontPage 98 is that the Tasks View has been moved front and center, where it belongs, with its own icon on the main FrontPage Explorer screen. As before, the Tasks subsystem lets you assign individual tasks, such as completing specific pages, to members of your design team. It works as a simplified project manager and goes a long way toward helping you keep track of the status of your site’s construction. Tasks View is especially appropriate in an intranet setting, where content is provided by a range of employees collaborating to build the site.

Navigation Bars and Shared Borders

With the combination of Shared Borders and Navigation Bars, FrontPage 98 lets you design Web sites that are easy for visitors to negotiate. Shared Borders provides a quick and convenient way to give your site a consistent appearance. Navigation Bars, which reside within these borders, greatly simplify creating and maintaining the links within a site. You can apply Shared Borders and Navigation Bars to an entire site at once, from FrontPage Explorer, and then, if necessary, individualize the borders of single pages within the site.
Navigation Bars are automatically created for any site that has shared borders. All you have to do is apply Shared Borders from within FrontPage Explorer, and every page on the site will share these borders and the corresponding Navigation Bars. Adding Shared Borders is simply a matter of choosing the command from the Tools menu in Explorer and deciding which of the four borders (top, bottom, left, right), or which combination or borders, you want. You can also insert shared borders from within FrontPage Editor, specifying them for the current page only if you wish.

Figure 8

With Shared Borders in place and changes applied within Explorer, the Navigation Bars are ready to be viewed. As an example, take a look at the Navigation View of the site in Figure 9 below:

Figure 9

The Home Page has three immediate “child” pages: News, Products and Services, each of which has its own child pages. The Shared Borders chosen above are top and left. When viewed in a browser, the first page of the site looks like this:
Figure 10
The hierarchy in the browser is the same as the hierarchy in Navigation View: Home Page is along the top, with the three child pages down the left border. Visitors can click any of those buttons and be taken directly to that page. Once they get there, assuming they clicked Products for this example, they’ll see a differently configured Navigation Bar, one that helps them work their way through this particular section of the site.

Figure 11
One strong usability feature with Navigation Bars is the ease of changing the labels on the Navigation buttons. If you rename the corresponding box in Explorer’s Navigation View, then apply the changes, the label on the button within the browser changes as well. You can customize your Navigation Bars within FrontPage Editor, making them even more useful to your site’s visitors. This is an extremely important feature of FrontPage 98.
Turning a Web Site Into a Channel

During the past year, push technology has emerged as one of the most important factors in the future of the World Wide Web. Several implementations of push technology exist, including those from news services such as PointCast and BackWeb, and Netscape Communication Corp.’s version called Netcaster, which can be added to the Netscape Navigator 4.0 browser. Push technology is so new that a single standard is not yet in place.

Microsoft’s proposed standard in this area, supported by a wide range of vendors, is the channel definition format (CDF), and it is built into the company’s Internet Explorer 4.0 browser. Users of that browser can subscribe to channels and have the content of those channels delivered automatically to their desktops. This means that Web site publishers no longer have to rely on users visiting their sites to have them see their information. Instead, users can come to their desktops in the morning and see the information waiting for them. This information can be updated on the users’ machines as soon as the Web site author changes it.

FrontPage 98 introduces the Channel Definition Wizard to allow you to publish your Web sites as channels to which users subscribe. This is a major and welcome new feature because it brings push technology to the Web-design community for the first time as an easily implemented feature. Simply put, this hasn’t been seen before in a popular Web-design product, and authors using FrontPage are expected to rely on it.

The wizard is a seven-step process that begins when you select Define Channel from the Tools menu. Figure 12 below shows the first dialog box of the wizard, in which you establish the title of the channel as well as the introductory page, the logo and icon images, and the plain-text abstract.

Figure 12

With these items set, clicking the Next button yields the Log Target dialog box. The purpose of the Log Target URL is to gather information about the user’s browsing behavior on your channel and relay that information to the Web page specified as the target. In this way, you can log activity on your channel to see how it is being used.

The next step involves setting a schedule for your channel to be served to users. By default, the wizard tells the channel to start serving immediately and to continue for
an unlimited time, but you can change these dates if you wish to offer a limited-term channel.

![Figure 13](image)

**Figure 13**

After establishing the user schedule, the wizard asks you to choose a directory that you will use to store pages that act as the source of information for the channel. Once this directory is selected, the wizard moves on to Edit File List dialog box, where you manually select the files within the channel’s folder that you want to exclude from being part of the channel.

In the next step, you establish the Channel Item Properties. Here, you select each item in the channel (an .HTM file, for example) and assign it specific properties. You can give it an abstract to help you remember its content, and you can specify whether or not the item should be cached in the user’s browser. You can also select whether each element will be served as a channel, an e-mail notification, a screen saver, or a desktop component; all of these are different ways users can receive push technology. The final step of the wizard is to name the .CDF file in which the channel information will be stored, and to determine whether or not to place a subscription button on the Navigation Bar of your site.

![Figure 14](image)

**Figure 14**

**Other Features in FrontPage Explorer**

FrontPage Explorer exists to help you create, organize, manage and update Web sites, and several additional features offer this assistance.
One-Button Web Site Publishing

Although FrontPage 98 lets you save your pages directly to a Web server, it’s often preferable to develop them locally and then publish the entire site to a server after it’s completed. FrontPage Explorer’s Publish button, found on the toolbar, opens a dialog box that copies the site to the URL you specify. Once it’s in place, you can continue to develop the site locally, publishing new content only as it’s readied. In this case, FrontPage offers incremental publishing, uploading only the portions of the site that have changed since the last upload. If your site is being developed collaboratively, the Publish feature also detects alterations by other group members and offers to resolve the differences by replacing or merging changes (see graphic below). If you have no server on which to publish your sites, the Publish dialog box contains a button that loads a Web page showing Web presence providers that support FrontPage-based sites.

Figure 15

Cross-Web Find and Replace

Making a change to a large Web site can be extremely time-consuming, especially if the change applies to information that appears on multiple pages. FrontPage simplifies these changes by providing Find and Replace functions that operate across the entire site. Words or phrases of any kind can be located anywhere on the Web site and replaced simultaneously. If a product name changes, for instance, you can ask FrontPage to locate all instances of the product name across all pages in the site and replace them with the new name.

Figure 16
As a guard against errors, the replacements don’t occur until the page is loaded into the FrontPage Editor, where you can verify that you do in fact want to make the change. One of the important points about the Cross-Web Find and Replace functions is that they demonstrate how FrontPage treats entire Web sites as, in effect, one large and multifaceted document, rather than simply a collection of linked pages.

**Cross-Web Spell Checking**

One of the easiest ways to lose a Web site visitor’s confidence is to festoon a site with incorrect or inconsistent spelling. The Tools menu of FrontPage Explorer offers a Spelling command that checks either the selected pages or, if desired, every page within the site. Like the Cross-Web Find and Replace functions, the spelling checker doesn’t correct the errors on its own; instead, it either opens the page for editing, or it simply adds a task to the Task View for every page on which an error exists.

**Link Verification**

The Hyperlink View in FrontPage Explorer displays broken links with a break in the line joining the two linked objects. It also displays the break in the left pane as a broken icon. This feature is particularly useful if you delete a page that has multiple links, or if your site is linked to other Web sites that change frequently. But manually checking every link in a large Web site is both tedious and prone to error, so FrontPage offers the Verify Hyperlinks command to automate the process.

To verify all the links in the current site, choose Tools/Verify Hyperlinks. The results will be displayed in the Hyperlink Status View, with links showing as OK, Broken or Unknown. In the case of Broken or Unknown links, you can either edit the page (using FrontPage Editor) that contains the offending link, or you can edit the link by double-clicking on it and revealing the Edit Hyperlink dialog box. If you edit the link from this dialog box, you have the option of automatically changing the link in every page where it appears, or only in a selected page.

**Page Creation and Design**

FrontPage 98 contains numerous enhancements to FrontPage Editor, its WYSIWYG page-authoring tool. The familiar interface remains, with its Office-style toolbars and easy formatting buttons, but a quick look through the menus shows a wide range of new features. Tables and frames have received extensive redesign, and support for Cascading Style Sheets and Dynamic HTML offers an entirely new level of control over document appearance and behavior. The automation features in FrontPage, now called components (formerly WebBot components), continue and expand Editor’s tradition of rendering programming unnecessary. Hover buttons and hit counters let users dress up their pages in new ways, and the new Banner Ad Manager lets pages cycle through a series of predesigned graphics. Graphical themes can be added to each page or across the entire site, and Navigation Bars can be inserted to enhance the ease of use of the resulting pages. FrontPage 97 was a strong Web authoring environment, but FrontPage 98 is better, more complete, and more supportive of the newest Web technologies.
The FrontPage 98 Editor Environment

FrontPage Editor is the primary tool for creating Web documents and keeping their content up-to-date. Figure 17 below shows the FrontPage Editor window:

![FrontPage Editor Window](image)

**Figure 17**

Tabbed Views

There are three tabs at the bottom of the FrontPage Editor window: Normal, HTML and Preview. These make the Web author’s job much easier by providing fast access to views that allow quick assessment of the design quality and behavior of the page. Instant switching between editing and evaluation is now possible.

- **Normal mode** is the editing mode, where the author actually puts a page together. It is WYSIWYG and provides immediate feedback about the appearance and positioning of added or modified page elements.

- **Preview mode** gives the author a window that shows not only how the page will look but how it will behave in a Microsoft browser. If Microsoft Internet Explorer 4.0 is installed on the host system, Preview mode will have all the capabilities (Dynamic HTML, full Cascading Style Sheet support and so on) of that browser. If Microsoft Internet Explorer 4.0 is not installed, the Preview mode uses the abilities of Internet Explorer 3.0.

The **HTML mode** tab opens a window where users can quickly access and manually edit their HTML source code. FrontPage 98 preserves more of the user’s hand-formatted HTML source code and includes better automatic formatting of algorithms to make the generated HTML code easier to read. A very useful feature is the ability to use Find and Replace while in HTML mode.

Previewing Pages in Browsers

The Preview in Browser command allows fast evaluation of site and page behavior in any browser installed on the host system. This is especially important given the
advent of Netscape Communicator and Microsoft Internet Explorer 4.0, both of which support new features that FrontPage 98 provides, such as Cascading Style Sheets and Dynamic HTML. Most of the time, the Preview tab in the Editor itself will be sufficient for previewing pages, but sometimes, especially as new features are added to HTML, launching the page in a full browser is necessary.

Creating Web Pages

FrontPage Editor works essentially like a specialized word processor, and its interface is closely modeled on that of Microsoft Word. So it will come as no surprise that you create a new Web page by choosing File, New and selecting from the list of templates that appears on the Page sheet, as shown below in Figure 18:

![Figure 18](image)

Apart from the Normal template — a blank page — there is a range of templates you can adapt for your own purposes. Some, like the Bibliography and Frequently Asked Questions templates, create content-specific pages with customizable hyperlinks and text or graphics placeholders already inserted. Others include embedded forms, such as the Feedback Form and the User Registration templates; there is also a Form Page Wizard. Most of the templates, however, provide you with preset layouts, such as various column arrangements with or without menu and sidebar positioning.

Immediately to the right of the template list is a preview of the page that will be created by the selected template. If you wish, you can mark the Just Add Web Task checkbox to simultaneously create a new page, add it to the current FrontPage-based site, and create a to-do task in the Task View of FrontPage Explorer.

After you click OK, the page appears in the FrontPage Editor work space. Its appearance will depend on the theme chosen for the current site; the default, when a site is created, is not to apply a theme. After you edit the page to your liking, you choose File, Save As to save it to the currently open site.

Improved Layout and Design Tools
FrontPage Editor gives you a comprehensive set of menus and toolbars specialized for the efficient creation of both simple and elaborate Web documents. For speedy access to major commands, there are six toolbars:

The **Standard Toolbar**, with a Preview in Browser button, a Create/Edit Link button, and Forward, Back, Refresh and Stop buttons. You also get buttons for inserting images, tables and FrontPage components (called WebBot components in earlier versions of FrontPage).

The **Format Toolbar**, with tools for adjusting text appearance and layout. With it you can do the following:

- Create bulleted or numbered lists, nest the lists and mix the types of list. With bulleted lists, a new feature is the ability to specify an image for the bullets. No longer are you restricted to a few generic, black bullet symbols.
- Use the Bold, Underline and Italic buttons to apply these character styles to selected text.
- Use the Change Style box to easily change paragraph or heading styles, or to apply a list style.
- Use the Text Color button to change the color of selected text.

The **Forms Toolbar**, with tools to insert various types of form fields into a form. These fields are text boxes, radio buttons, check boxes, drop-down menus and pushbuttons.

The **Advanced Toolbar**, which helps you enliven your pages with ActiveX components, Java Applets, plug-ins, Visual Basic programming system-based and Java scripts, and HTML code.

The **Table Toolbar**, new for FrontPage 98, which provides an excellent new table-creation feature, the Table Drawing Tool, which lets you draw a table directly into the FrontPage Editor work space. With these new tools you can accomplish the following:

- Draw tables directly on the Web page
- Resize, delete and add cells, rows and columns
- Merge and split cells
- Align cell content
- Automatically distribute rows and columns evenly
- Add background color

The **Image Toolbar**, which has so many features new in FrontPage 98 that a later section will be devoted to them.

**Using Images**

Inserting images is as simple as clicking the Insert menu, then clicking Image. From the resulting dialog box, you can select the image from a file on the FrontPage host machine, from a location on the World Wide Web, or from a bank of over 1,000 ClipArt images that are supplied with FrontPage 98. The source image can be any of the major graphics file formats, but on saving the page, FrontPage Editor
automatically converts the graphic to your choice of JPEG or GIF; the former can be progressive, the latter can be transparent or interlaced. When you save the page, you can also elect either to import the image file into the current FrontPage-based site, or leave it in its current location and let the page access it by its URL.

Integrating text with images isn’t at all complicated. For example, FrontPage Editor supports floating images, so you can align a block of text next to an image. All you do is double-click the image to open the Image Properties dialog box. Then click the Appearance tab, as shown in Figure 19, and use the Alignment list box to select “left” or “right.” This will make existing or inserted text flow around the image.

![Figure 19](image.png)

Finally, for those times when things didn’t go at all as you wanted them to, there’s a multilevel undo. Keep clicking the Undo button to back up over your previous 99 actions.

Enhanced Image Editing Tools

FrontPage 98 provides improved image processing all around. A wide array of image handling tools is available from the toolbar (see Figure 20):

![Figure 20](image.png)

The first five buttons make the creation of image maps as easy as dragging the mouse pointer. The three shape buttons draw rectangular, circular or polygonal hot spots. The large arrow button allows you to select a hot spot, and the small arrow button lets you highlight a hot spot to make it easier to see on a complex image.

The Text button (the “A”) makes creating labeled GIFs, or simply creating a text hot spot in an image map, as easy as placing a text box on an image and typing in it.

The small, blue pencil-eraser button is the Make Transparent tool. If you’ve been using an image processing program to make transparent GIFs, you can stop doing
so. With this tool, you just click the color you want to make it transparent, and it’s done.

The double-x button is for cropping. Again, this releases you from the distraction of having to go to an image processor every time you want a fast crop of a graphic. Better yet, you can see the crop right on the page — no more need to switch back and forth between the graphic program and FrontPage Editor to get the cropping exactly right.

The next button lets you wash out images by 50 percent; the one on its right changes a color image to black and white.

To the right of the Make Black and White button is the Restore Image button. This is for those times when you need to start over. Click the button, and you get the untouched image back in the work space. It’s very handy if you need to do a fair amount of experimenting.

The four buttons that come next (the purple and gray triangles) are the rotation, reverse and flip tools. If you don’t like the orientation of an image, change it with a click or two.

The next four buttons let you adjust the image contrast and brightness. This again relieves you of the need to flip back and forth between a graphics program and FrontPage Editor to get the contrast and brightness ratios properly set in relation to the rest of the page.

The Bevel button is a great way to create a bevel-edged button from an image without doing the beveling pixel-by-pixel.

Finally, the Resample button allows you to change the file size of an image instantly to match the current size in which it’s displayed. Reducing the size of an image reduces download time and keeps visitors happy.

Auto Thumbnail

Another new image processing tool, which is found in the Tools menu, is the Auto Thumbnail command. This timesaver takes a large image you have already inserted into the page, resizes it, and automatically sets up a hyperlink to the large original image. When you save the page containing the thumbnail, FrontPage Editor will save it as a smaller, renamed file in the current site. The large original of the thumbnail is left in its original location, wherever that might be.

Multiple Fonts and Font Formatting

FrontPage Editor supports the use of TrueType fonts in any Web document. The author can use any font available on the host machine. Changing fonts is done almost exactly as it is in a word processor, using the Font dialog box (see Figure 21). Typeface, size, color and font attributes can all be changed.
Figure 21

If you prefer not to use TrueType fonts in part or all of a Web page, the Special Styles sheet in the Font dialog box gives you HTML’s physical or logical character styles such as Bold, Citation and Definition, as well as superscripts and subscripts.

FrontPage 98 Hyperlinks

With FrontPage 98, you can create different types of hyperlinks using the FrontPage Editor Hyperlink dialog box. To do this, first open the page and select the text or image that is to be the link. Then choose Edit, Hyperlink from the menu bar. This opens the Create Hyperlink dialog box, as shown in Figure 22:

Figure 22

This dialog box lets you specify the destination of the hyperlink. The list box shows all the pages owned by the current site, and indicates with a special icon (a sheet of paper with a red quill) which of these pages is currently open in FrontPage Editor. In this dialog box you can accomplish the following:

- Link to a page in the current site
- Use your default Web browser to link to a Web page at a remote location
- Link to a file
Create a link that will send e-mail to a specified address

Finally, you can use a shortcut method that creates a link to a new page and
opens the New Page dialog box so you can specify what kind of page it’s going
to be.

Newly linked pages have to be saved to update the various graphical displays in
FrontPage Explorer. Also, if you edit a hyperlink, you should save its page before
you use the Preview in Browser command. The Preview in Browser feature gets its
linking information from the file on disk, so if you don’t save, the link won’t be
updated.

Finally, there will be times when you want to remove a link. To do this, place the
insertion point anywhere inside the link (or select the graphic) and choose
Edit/Unlink.

Cascading Style Sheet Support

FrontPage 98 provides full support for both linked and embedded Cascading Style
Sheets, as well as for the use of inline styles.

To create a style, open the page where the style definition is to reside. Make sure
you’re viewing the page in Normal mode, then click Format/Stylesheet to make the
Format Stylesheet dialog box appear (see Figure 23):

Figure 23

FrontPage Editor uses a non-WYSIWYG approach to creating a stylesheet. You
place the insertion point between the <!-- and --> symbols, then type the tag of the
page element you want to style, then assign a style or styles to this element. In the
Editor Walkthrough, later in this guide, the process of doing this will be examined in
more detail.

Custom Templates

If none of the standard FrontPage 97 page templates suits your needs, you can set up
your own and add them to the New Page template list. First use the FrontPage Editor
tools to design the look and layout you want, and then choose File/Save As. The
Save As dialog box, shown in Figure 24, appears:
Click the As Template button, and give the page an appropriate title and file name. You can add a description of the template in the box provided. Then click OK to save your custom template.

From now on, whenever you choose File/New you’ll see an entry for your template in the New Page list box. If you gave it a description when you saved it, that description will appear at the bottom of the New Page dialog box.

**Forms Support**

To use forms successfully with FrontPage 98, the server hosting the Web site must have the FrontPage server extensions installed. This is automatic with the Microsoft Personal Web Server in FrontPage 98, and with the Microsoft Internet Information Server.

The Form Page Wizard removes much of the drudgery associated with forms, because it both supplies suitable formatting and inserts the required form handlers automatically into the page. To start the wizard, open FrontPage Editor and choose File/New to open the New Page dialog box. Select Form Page Wizard and move through the dialog boxes, creating the needed form fields and input specifications as you go.

When you’ve added all the fields and form components you want, use the Presentation Options dialog box to set up the look of the form. Specifying how you want the collected information saved is done with the Output Options dialog box. Here you can choose any of these options:

- Save the form results to a Web page (the default)
- Save the form results to a text file
- Use a custom CGI or other script (which you must supply)

When you’ve completed the steps in the wizard, FrontPage Editor immediately generates the form page. You can now customize it as much as you want, using the normal editing tools and the Insert/Form Field commands if you require further input fields.
Custom Forms

Creating custom forms from scratch is somewhat more complex than using the Forms Wizard, though still far simpler than writing HTML. Essentially, you use the Insert/Form Field commands (or the corresponding Forms Toolbar buttons) to place form fields on the page. You have these types of field:

- Text box (one-line and scrolling)
- Check box
- Radio button
- Menu
- Pushbutton
- Image (the graphic is actually a dedicated Submit button)
- Label

As soon as you insert the first form field, a dotted form boundary appears around it. For each field added, you can specify the required type of input by editing its Form Field Properties.

When the form is finished, right-click in a blank area of the form, then choose Form Properties from the shortcut menu. The Form Properties dialog box appears, as shown in Figure 25.

![Form Properties dialog box](image)

**Figure 25**

Here is where you specify the file name and format for data obtained through the form. Click the Options button to access tabbed sheets where you can set various parameters for the output of the form, including the file where it’s to be saved, a custom confirmation page, and e-mail redirection.

E-Mail Form Results

A major innovation in FrontPage 98 forms is the ability to send form results directly to an e-mail address. These results can be sent as several different formats including HTML, various text database formats and HTML lists. To set up an e-mail destination and formatting for the user’s input, open the Form Properties dialog box, click the Options button, and click the E-Mail Results tab.
Frame Layout Tools

FrontPage 98 introduces WYSIWYG frames page creation, which makes a Web author’s life a lot easier. You can see exactly what you’re doing, while you’re doing it.

You begin a frames page by choosing File/New in FrontPage Editor and clicking the Frames tab to display the Frames sheet (see Figure 26):

![Frames sheet](image)

**Figure 26**

Several templates are supplied:
- Banner and Contents (three frames)
- Contents (two frames)
- Footer (two frames)
- Footnotes (two frames)
- Header (two frames)
- Header, Footer and Contents (four frames)
- Horizontal Split (two frames)
- Nested Hierarchy (three frames)
- Top-down Hierarchy (three frames)
- Vertical Split (two frames)

Select any template to get a schematic representation of how the pages will be laid out within the frames page and to see a description of what the frames page does. When you have selected the set you want, click OK. In the dialog box that follows, you can specify the initial page for each frame of the frames page; you can either specify existing pages or create new ones on the fly. The appearance and behavior of the frames page can be modified by right-clicking any frame, then choosing Frame Properties from the shortcut menu.

If the provided templates don’t suit your needs, you can edit a frames page to make a new arrangement. Begin by creating a frames page that resembles the one you want.
Then go to the Frame menu and select the Split Frame or Delete Frame commands as needed.

When you link the pages, the name of the target frame for each link is specified by the chosen frame template; or, if you customize a frames page, FrontPage Editor supplies the frame names, which you can then use as targets. These targets can also be customized from the Edit Hyperlink dialog box. A detailed frame example will be given later in this guide, in the Editor Walkthrough.

Creating and Editing Tables

Many Web page authors make heavy use of tables to control layout. Recognizing this, Microsoft has introduced in FrontPage 98 the ability to draw tables directly onto the Web page in the FrontPage Editor environment. This new Table Drawing Tool feature makes table setup far easier and more intuitive, and the provision of a Table Toolbar along with it puts the most frequently needed table functions at the Web author’s fingertips.

To create a table, go to the Table menu and click Draw Table. This action also makes the Table toolbar appear. When you return the mouse pointer to FrontPage Editor’s work space, you see a pencil, which you then drag to produce the outline of the table. When you’re satisfied with the shape and size, release the mouse button, and you’ll see that you’ve created a single-celled table. It defaults to a border width of one pixel, but this of course can be changed.

You then make this single-celled table evolve into a more complex one by dragging the drawing tool within it. Dragging horizontally creates rows; dragging vertically creates columns. The technique is very much like drawing straight lines in a simple graphics program (see Figure 27; the Table Toolbar is visible, and the Drawing Tool is about to add a new row to an existing table):

![Figure 27](image)

A cell border can be repositioned by placing the mouse pointer on top of it, so that the pointer becomes a double-headed arrow, and dragging the border.
Removing a cell border — merging cells, in other words — is straightforward. The Table toolbar has an eraser tool; select this, and drag it on top of any cell border so that the border changes color. Release the mouse button, and the border vanishes.

Tables can also be created by specifying values in a dialog box, as was done in FrontPage 97; to access this dialog box, go to the Table menu and choose Insert Table. To modify a table’s properties, right-click it and choose Table Properties from the shortcut menu. We’ll look at these features more closely in the Editor Walkthrough.

Active Elements

FrontPage 98 provides several elements that provide intelligent design assistance to Web site authors. The following are key elements:

- **Hover button.** This is a Java Applet that allows animated effects when the mouse pointer hovers on the button. You can also apply custom images to the button, as well as sound effects that play when the button is clicked or hovered over.

- **Banner Ad Manager.** As its name suggests, this Java Applet provides a banner advertisement area on the page. The display moves from one image to another (many images can be used) with various transition effects such as dissolves, box in/box out, and so on.

- **Marquee.** This is a straightforward marquee element, with sizing, direction, speed and other necessary controls.

- **Search Form.** This FrontPage component provides a search tool that will look for a text string in the current FrontPage-based site. Start and Reset buttons are supplied automatically, and the report options include the closeness of the match, the date stamp of the file where the match was found, and the file size.

- **Hit Counter.** This FrontPage component puts a hit counter on the page. You can select from several numbering styles.

- **PowerPoint Animation.** If you have created a PowerPoint animation, you use this command to insert the file and have it handled either as a plug-in or an ActiveX component, depending on the target browsers.

- **Video.** This adds a video file to a page, using the DYNSRC= property.

Dynamic HTML

Dynamic HTML (DHTML) allows on-the-fly modification of a Web page, provided that the browser displaying that page is a DHTML-enabled browser. In such a browser, a DHTML page can change its appearance and its behavior in response to mouse or keyboard actions undertaken by the person using the browser. This enhanced ability to respond to users’ input is the reason for characterizing this development of HTML as “dynamic.” Even browsers that don’t support DHTML, however, will function with it; they will simply provide a static rendition of the interactive elements.
FrontPage 98 introduces three major DHTML effects to enhance Web pages (see the Editor Walkthrough for more detail):

**Dynamic Outlining.** This capability permits the page author to produce “collapsible” outlines. The basis for the effect is a standard HTML bulleted or numbered list whose items have subordinate (nested) lists under them. When a viewer sees the list in a DHTML-enabled browser, only the headlines will be visible, but when he or she clicks a headline, the information subordinate to that clicked headline will appear. In browsers that do not support this feature the full list appears, uncollapsed.

**Page Transitions.** These allow wipes and dissolves of pages as the user enters or exits them, in a manner similar to that used in PowerPoint slide shows. Non-DHTML browsers simply make the transition without displaying the effect.

**Animation.** This offers a dizzying array of text or image movement on entry to the page, from spirals to zooms. Non-DHTML browsers simply display the text, without any animation.

### Integration with Applications, Browsers and Servers

#### Integration with Microsoft Office

FrontPage 98 is part of the Microsoft Office family, and as such it is integrated with that suite of applications. The most noticeable integration is the user interface, with its similar toolbar and its nearly identical interface. Drag-and-drop capabilities are also similar to those in Office, and files can be dragged into FrontPage from any Office application. The FrontPage views display Office documents with their native icons, and these documents can be launched into their initial applications for editing then saved back into the site. FrontPage 98 works seamlessly with hyperlinks created in Office documents (which is extremely useful for intranet building), and it can convert Office documents from their native file format to HTML.

FrontPage 98 is further integrated into Office with its use of shared tools, helping to preserve both disk space and customization time. FrontPage 98 uses Office’s spelling checker and thesaurus, as well as any clip art that has been installed for those applications. Furthermore, this integration applies across the various platforms for which Office versions are available: Windows 95, Windows NT and the Macintosh.

#### Integration with Windows NT Server

Windows NT Server and its corresponding Microsoft Internet Information Server have emerged as an important Web site hosting platform. FrontPage 98 offers increased integration with this platform, to the degree that it has become a primary Web development package even for complex IIS-based sites. To begin with, the FrontPage 98 server extensions for IIS 4.0 are now part of the setup and administration of that server. Equally important, the server extensions are no longer based on the CGI but are now Internet Server API DLLs. As IIS progresses, this means that the server extensions can be updated to reflect and support new IIS technology directly.
FrontPage 98 offers many other IIS integration points. The Database Region Wizard lets you specify precisely which regions of a database you want served with your site and takes you through the process of creating fully functioning Active Server Pages links to data. ASP itself is more fully supported, in fact, with FrontPage Editor now able to handle pages that contain ASP code. FrontPage 98 and Microsoft Visual InterDev now share the same HTML editor, so development teams using both tools can more easily combine their efforts. Third parties wishing to enhance FrontPage 98 and Visual InterDev together can produce Design Time ActiveX Controls, which work much the same as FrontPage components but are compatible with both development products. Finally, FrontPage 98 now integrates with Microsoft Visual SourceSafe for further security, and with Microsoft Index Server for full search capabilities across complex sites.

Integration with Microsoft and Netscape Browsers

Increasingly, Web designers want no part of producing separate sites for separate browsers. Doing so is not only too time-consuming and difficult, it also works against the universality that the World Wide Web was invented for in the first place. FrontPage 98 produces its code in HTML, not in proprietary formats, and is compatible with the HTML 3.2 standard. In addition, it offers support for many of the HTML tags and containers that have become part of the HTML 4.0 standard. Hover buttons and Navigation buttons are created as Java Applets, thereby ensuring that users of Netscape Navigator, Microsoft Internet Explorer, or any other Java-compatible browser can use them. Features such as Cascading Style Sheets, Dynamic HTML and the channel definition format are also included in FrontPage 98 and are viewable within Netscape Communicator 4.0 and Microsoft Internet Explorer 4.0. ActiveX components and Active Server Pages, however, are viewable within Internet Explorer only.

Support for Web Server Software

The whole point of designing Web sites is publishing them, and FrontPage 98 Server Extensions provide even stronger server support than before. The extensions provide Web server software with the ability to host FrontPage-created sites, so that the programming features of FrontPage 98 such as forms, discussion groups, database integration, and searches all function appropriately. Extensions for all major UNIX, Windows NT- and Windows 95-based servers are in place, and many Internet service providers are installing these extensions to allow their users to produce and mount sites developed with FrontPage.

Because of their cross-platform nature, server extensions are often complex. As a result, included in the FrontPage 98 package is the Server Extension Resource Kit, a set of HTML pages that provides assistance with installing and configuring extensions on Windows NT- and UNIX-based servers. The SERK addresses issues such as security and multihoming, as well as details about directory and file creation on the server. UNIX service providers also gain a series of scripted installation routines with the FrontPage 98 release. The server extensions now support remote...
server administration as well as support for the most recent Apache and Netscape server releases.

Hands-on Exercises

Installing FrontPage 98

FrontPage 98 is easy to install, as the graphic below indicates. Only three choices present themselves to you on installation: FrontPage installation, Image Composer installation and Internet Explorer installation. Many users will already have Microsoft Internet Explorer, in which case only the first two will matter.

Figure 28
When you select Install FrontPage 98, you install all components of the main package:

FrontPage Explorer, the tool for planning, creating, organizing, managing and updating Web sites
FrontPage Editor, the word-processor-like HTML editor for full WYSIWYG page creation
FrontPage Server Extensions, the code that allows popular Web servers to work properly with FrontPage features such as forms and components
FrontPage Server Administrator, the tool for applying and upgrading server extensions and administrative permissions

If you are installing FrontPage 98 on a Windows 95-based system, the installation program gives you the option of installing Microsoft Personal Web Server as well. A server is necessary to test your sites, or eventually to publish them, and the Microsoft PWS is easy to use and reasonably powerful. FrontPage 98 also ships with the original FrontPage Personal Web Server, but to install it you must specify a Custom install, since it’s no longer considered part of the main package. It ships for backward-compatibility purposes only.

Getting Started in the FrontPage Explorer

The first thing you see on opening FrontPage 98 is the Getting Started dialog box on top of FrontPage Explorer. From this dialog box, you can open an existing site or
create a new one. A Web site can exist on a local Web server, or — and this is one of the major features of FrontPage — on a server on a remote machine instead. The Web site(s) most recently worked on appear(s) in the small window, but users can open others by clicking the More Webs button.

Figure 29

For the sake of this guide, we’ll create a new site instead of opening an existing one. To do so, work along with the following procedure:

1. Click the radio button called “Create a New FrontPage Web” on the Getting Started dialog box, then click OK. You’ll see the dialog box in Figure 30. Note that you can create a simple one-page site to get started, or you can import an entire site that was created with different tools.
2. Click the Corporate Presence Wizard choice in the window to highlight it, then name your site “MyCompany” by typing in the field under “Choose a title for your FrontPage Web site.”

3. Click the Change button and, in the resulting dialog box, type http://localhost/MyCompany. The location localhost places the site on the Web server on your local machine (and can also be specified by http://127.0.0.1/).

4. At this point, the Corporate Presence Web Wizard will appear. Work your way through the wizard by selecting from among the choices and clicking the Next button. One example of this wizard’s choices appears below, allowing you to choose which information you’d like to receive about your visitors when they submit comments about your site.

5. When you click the Finish button, FrontPage creates the site. At this point, you have a full site with many individual pages to work with, and you can add or delete pages as you wish, and change design elements in any way you choose. The wizard has produced a site with a strong hierarchy and with advanced features such as feedback forms, and now it’s up to you to individualize it further. To do so, you’ll use a combination of FrontPage Explorer and FrontPage Editor.
Besides the Corporate Presence Web Wizard, FrontPage 98 offers one additional wizard, the Discussion Web Wizard. This wizard takes you through the creation of a bulletin-board style discussion site, where users post comments and reply to those of other users. You can allow any visitor to access the discussion, or you can restrict participation to registered users only. After asking you several questions about the design of your discussion site, the wizard generates the documents necessary to allow users to register for the site and to engage in the discussions.

Three other choices are available from the Create New Web dialog box, but none are wizards. If you select Customer Support Web, FrontPage generates a site that lets your customers make suggestions, discuss your products and services with other customers, read FAQs, post bug notices, and download software as you make it available. The Project Web gives you a site with an archive of documents, a discussion area and information about schedules, task status and individual team members. Finally, the Personal Web generates a small site in which you can place personal and professional information about yourself, including a resume.

Using the Navigation View

The following brief tutorial demonstrates some of the power of Navigation View:

1. Create a new site (File/New/FrontPage Web) and select the Project Web. Name it MyCompProjects.
2. Open the Navigation View if it’s not already open. You’ll see a single icon labeled “Home,” along with a message explaining that you can add pages to the structure by clicking the New Page button or by dragging pages from the contents window below.
4. Now, right-click Activities and create a new page called “Softball.” Right-click Activities again and create another new page, this one called “Parties.” Right-click Activities a third time and create a page called “Job Review.”

5. At this point, you decide that Softball and Job Review are two very different types of activities and that you want to separate them into on-the-job and off-the-job activities. First, right-click the Activities icon, select Rename, and type “Job Activities.” Now, right-click Home, select New Page, and call it “Fun Activities.” You will now have two icons below the Home page (Job Activities and Fun Activities) and three icons attached to the Job Activities page.

6. Now it’s time to attach the activities to their appropriate parent icons. To do so, simply drag them from their current parent until the line displays them attached to the other, then drop into place. Figure 32 shows the highlighted Parties icon being dragged from the Job Activities parent to the Fun Activities parent; while dragging, the icon is ghosted.

7. Open your Web browser. In the URL field, type the URL shown just above the Contents pane of the Navigation View. You’ll see your site, with the borders at the top and to the left displaying the buttons you created in Navigation View. Click around the browser and see what transpires.

8. Now return to Explorer and click the Hyperlink and Navigation Views on the Views Bar in Explorer to see how your site looks.

9. Click Themes View. It’s time to add some graphic consistency to this site. Scroll down the list of themes until you find one you would like to use. Click that heading, and then toggle on both Vivid Colors and Active Graphics to give your site more flair. Now click Apply. Explorer will upload the needed graphics and style files to the server and apply them to your site.
10. Return to your browser, Refresh the screen, and see what your new site looks like.

Figure 33

You can delete pages from inside Navigation View. To do so, right-click the page icon and select Delete or press the DELETE key on the keyboard. You'll be given the choice of removing the page only from the Navigation View or from the site itself. In the first case, you're simply hiding the page from the view, but it still exists. In the latter case, the entire file is deleted.

If you want to work on editing a page whose icon appears in Navigation View, simply double-click the icon to load the page into FrontPage Editor.

Creating and Editing a FrontPage-Based Web Site

In this section, we'll create and use an initially empty FrontPage-based Web site to work through several key FrontPage Editor procedures. Follow these steps to set this up:

1. Start FrontPage. In the Getting Started dialog box, click the Create a New FrontPage Web radio button, then choose OK to open the New FrontPage Web dialog box.

2. In the upper list box, select Empty Web.

3. In the lower list box, type a title for your FrontPage Web. Choose OK to make FrontPage Explorer create the site. If asked, enter your user name and password.

4. When the site opens in FrontPage Explorer, choose Tools, Show FrontPage Editor from the Explorer menu bar or click on the FrontPage Editor button on the toolbar.

5. FrontPage Editor appears. From its menu bar, choose File/New. When the New dialog box appears, select Normal Page and click OK.

6. A blank Web page appears in the editor work space. Figure 34 shows the major editing controls you use with FrontPage Editor.
Basic Text Entry and Editing

Look at the Change Style box in Figure 34. To select a style, click the button at the right of the box to show the drop-down list of available styles, as shown in Figure 34. Select Heading 1, and type a heading. This produces the largest size of HTML heading, with a default font face of Times New Roman.

Press ENTER at the end of the heading line. The Change Style box now shows Normal, which indicates standard HTML text. Now you can start typing body text. As usual with HTML-based pages, you get a blank line between paragraphs every time you press the ENTER key. To prevent this, use CTRL+ENTER to start a new paragraph.

All the standard HTML styles are available from the Change Style box. For example, to change a paragraph from Normal to Formatted text, place the insertion point in the paragraph and choose the Formatted style from the drop-down list.

FrontPage Editor has cut and paste capability and supports drag-and-drop functionality for selected text or images. To center, left-align, or right-align a paragraph, click the appropriate button on the toolbar.

Character Formatting

Character formatting in FrontPage is almost identical to that in a word processor. FrontPage Editor supports the &lt;font face=&gt; tag, so you can use any font installed on your host machine. To change the font of existing text follow these steps:

1. Select the text, then click the button at the right of the Change Font box.
2. Select the font you want from the drop-down list, and the selected text changes appearance.
3. To enter new text in a different font, choose the font and begin typing.
You add character attributes by selecting text, and clicking the Bold, Underline or Italic buttons on the toolbar. In the same way, click the Text Color button to change text colors.

Using Images

You place a GIF or JPEG graphic on a page with the following procedure:

1. Choose Insert/Image from the menu bar or click the Insert Image button on the toolbar. Now you see the Image dialog box, as shown in Figure 35.

![Image dialog box](image)

**Figure 35**

2. At the right of the URL text box, there are two buttons. The right-hand one lets you select an image file from those stored on your host machine. Click it, and the standard Windows 95 file selection dialog box appears. Locate the image file you want, and click Open. The dialog box closes, and the image immediately appears on the page.

FrontPage Editor supports “floating alignments” that allow text to flow around an image. To apply such an alignment, do this:

1. Right-click the image you just put on the page, and select Image Properties from the shortcut menu.
2. In the resulting Image Properties dialog box, click the Appearance tab.
3. In the Layout section of the Appearance sheet, click the arrow at the right of the Alignment box to make the drop-down list appear.
4. Click “left” or “right” to pick the desired alignment, then click OK. Existing or future text will now wrap around the image.

To delete an image, select it by clicking on it once. (You know an image is selected when black sizing handles appear at its boundary.) Press the DELETE key to get rid of the image.

Saving the Page to Your Web Site

To save the new page, choose File/Save, or File/Save As. The Save As dialog box appears, as shown in Figure 36:
Making Hyperlinks

You can make a link from either text or an image. To begin, create a page that will be the target of the link. Then use the Window menu to make active the page where the link itself will reside. Select some text or an image to serve as the hyperlink, and then do this:

1. Choose Edit/Hyperlink to open the Create Hyperlink dialog box, as shown in Figure 37:
2. The list box shows all the pages that belong to the current site. If a page is open in FrontPage Editor, it appears a second time at the top of the list, with a quill and page icon beside it. Click the listing of the page that is to be the target of the link, then click OK.

3. To check the link, make sure the origination page is the active page in FrontPage Editor. Then click the Preview tab, and in that view, click the link. The target page should appear. Click the Normal tab to return to the editing mode, which will still show the origination page with its link.

4. To update the FrontPage Explorer display, choose File/Save All to save all open pages.

To edit the link, select it, then choose Edit/Link. The dialog box, except for its title, is identical to the one in Figure 37 above. Change the link destination as needed, then exit the dialog box. To remove a link, click it and choose Edit/Unlink.

Linking With Drag and Drop

A second, faster method of creating a hyperlink is to drag a page icon from FrontPage Explorer into the FrontPage Editor workspace. To do this, first use FrontPage Editor to open the page that will contain the link, and tile the Explorer and Editor windows. Then make the FrontPage Explorer window active, and click the Hyperlink View button on the toolbar. Find the page icon you want, then drag it into the already-open page in FrontPage Editor. The mouse pointer changes to a shortcut icon when you’re in the Editor work space; position this icon where you want the link to go, and release the mouse button. The page title of the destination page immediately appears as a text hyperlink. You can then edit this link text as needed.

To edit an existing link, click it and then click the Create or Edit Hyperlink button. The dialog box that appears is titled Edit Hyperlink but is otherwise identical to the Create Hyperlink dialog box. Modify the link as needed, then click OK. To update the FrontPage Explorer display with the modified link, save the page.

Using Bookmarks
Bookmarks (named anchors, to use the formal HTML term) are equally simple. In the destination page, select the text you want to use for the bookmark (note that you can’t use an image as a bookmark). Then choose Edit/Bookmark to go to the dialog box shown in Figure 38:

![Bookmark dialog box](image)

**Figure 38**

In the Bookmark Name text box, either accept the default for the bookmark name, or type in a new one, and then click OK. A dotted line appears under the selected text. Now make active the page that will contain the link to the bookmark. Select the image or text for the hyperlink, and click the Create or Edit Hyperlink button. In the Create Hyperlink dialog box’s list box, select the page that contains the bookmark that is to be the target of the link. Then, in the Optional section of this dialog box, use the Bookmark drop-down list box to find the name of the target bookmark. Select the name, and click OK to establish the link.

**Creating Image Maps**

Creating image maps with FrontPage Editor is highly intuitive. After you insert the graphic into the document, single-click it to select it. Sizing handles on its borders show that it’s selected, and selecting it also automatically opens the Image toolbar.

Now, in the Image Toolbar, click either the rectangle, the circle or the polygon buttons. Then move the mouse pointer to rest on the graphic, and you’ll see that the pointer looks like a pencil. This is the hot spot drawing tool. Hold the left mouse button down and drag to outline the size and shape of the hot spot you want. As soon as you release the button, you see the border of the hot spot, complete with sizing handles, and the Create Hyperlink dialog box automatically opens. Set the link up appropriately, and choose OK.

Sometimes the image colors make it hard to see the hot spot borders. If this happens, click the Highlight Hotspots button, and only the hot spot itself will be visible.

To edit a hot spot, simply click the image, and the hot spots appear. You can resize them with the resizing handles, or drag them from place to place. To edit the link associated with the hot spot, click the hot spot, then click the Create or Edit Hyperlink button to open the Edit Hyperlink dialog box. Edit the link, then click OK.

Finally, to delete a hot spot and the link associated with it, click the hot spot and press the **DELETE** key.

**Putting a Table on a Page**

Now you’ll add a simple table.
1. Go to the Table menu and select Draw Table. The Table toolbar will appear, and when you move the mouse pointer into the work space it will turn into the table-drawing tool.

2. Drag the table-drawing tool through the Editor work space until you have a rectangle that’s about the size of the table you want.

3. Drag within the cells to create new cells, columns or rows. (A little experimentation may be necessary.)

4. Place the drawing tool on top of any cell border until the pointer becomes a double-headed arrow. Drag this to adjust the size of the cell or the table.

5. From the Table toolbar, select the Eraser to turn the mouse pointer into the eraser. Hold the left mouse button down while dragging the eraser over the cell border you want to erase. When the border has been selected, it will be highlighted. Release the mouse button, and the cell border will vanish. (Note: In some configurations of cells, certain borders cannot be erased.)

6. You can adjust the table’s properties further with the Table Properties dialog box. (For example, if you’re using the table as a layout aid, you likely won’t want the borders to be visible.) Right-click anywhere on the table and choose Table Properties from the shortcut menu to make the dialog box appear, as shown in Figure 39:

![Figure 39](image)

In this dialog box you can alter and/or specify the following:

- Table size in rows and columns
- Alignment (default, left, center, right)
- Border size: the width in pixels of the cell and table borders (0 specifies no borders)
- Cell padding: the number of pixels between the edge of the cell content and the table boundary
- Cell spacing: the number of pixels between cells
- Width, in pixels or as a percentage of a browser window
Cell border colors
Background image or background color

Cells can be individually edited. Click a cell, and choose Table/Cell Properties to reach the Cell Properties dialog box. You have options for aligning the content of a cell, for making the cell a header cell, and for changing the cell colors.

The Table menu provides several other commands for table manipulation, including insertion of columns, rows and cells, and splitting and merging cells. These largely duplicate the results obtained with the table-drawing tool.

Selection commands allow you to select a column, row, cell or the entire table. To delete a cell, row or column, or the entire table, you select the appropriate menu command and press the DELETE key. To add text to the table, simply place the insertion point in a cell and type. Cells can contain anything a page can, including other tables.

Using Lists

Making lists in FrontPage Editor is straightforward. Place the insertion point where you want the list to start. Then, to make a bulleted list, do this:

1. Click the Bulleted List button on the toolbar. A bullet appears in the work space.
2. Start typing your list, pressing ENTER at the end of each item.
3. When you’re finished, press ENTER twice to stop inserting bulleted items.
4. If you need to insert an item into the list, position the insertion point immediately to the right of the preceding item, press ENTER, and type the new item.

If you want to create a numbered list, click the Numbered List button before beginning. To change one list type to another, click anywhere inside it, then click the appropriate button.

Previewing Your Work

You don’t need to be connected to the Internet to do this. Simply make active the page you want to preview, and choose File/Preview in Browser. The Preview in Browser dialog box opens, as seen in Figure 40:

Figure 40
All the browsers installed on your host machine appear in the list box. Leave the Window Size set to Default, which uses the current resolution of your display. Select the browser you want, and click Preview. The selected browser starts, loads the page, and displays it to you. When you’re ready, close the browser to return to FrontPage Editor.

Creating a Frames Page

In this next sequence, we’ll create a frames page with two frames, and populate it. Assuming you’ve gone through the procedures above, you’ll now have two pages in your site. To best illustrate WYSIWYG frames page behavior, you’ll need more pages, so create another page, give it a title and file name, and save it. You should also type something into the page before saving it, so you’ll be able to identify it on sight.

Begin by choosing File/New to open the New dialog box; then click the Frames tab to display the available frame templates. For this example, select Header, which gives you an upper frame whose links will change the page displayed in the lower frame. Click OK. Now you have the screen shown in Figure 41:

![Figure 41](image)

Now do this:

1. You can insert an existing page into any frame, but for purposes of illustration we’ll create a new one for the upper frame. In the upper frame, click the New Page button, and a new, blank page appears there. We’ll use this page for the hyperlinks that control the display in the lower frame.

2. In the lower frame, click the Set Initial Page button. This opens the Create Hyperlink dialog box. From the list box, select an existing page, then click OK. This page opens in the lower window. (If you look in the FrontPage Editor title bar at this point, you’ll see that there are two page titles given. The first is that of the active page; the second is the title of the frames page file itself.)
3. Click in the upper frame. Insert a hyperlink to the page that is currently appearing in the lower window. Then, still in the upper frame, insert a second hyperlink, to a different page.

4. Use File/Save All to save the frames page file and the new or changed pages. You’ll be asked to supply names for any new files.

5. Use the Preview in Browser command to test the frames page. You should see a display like the one in Figure 42. Clicking the links in the upper frame should switch the page appearing in the lower frame.

Figure 42
To edit the frames page later, simply open the frames page file in FrontPage Editor. It will appear with its assigned initial pages displayed.

If you want to save the frames page without saving the pages displayed in it, click the Frames Page HTML tab at the bottom of the editor work space while you’re working on the frames page. When the HTML page appears, choose File/Save As and provide the page title and file name.

If you want to establish your site as a “framed” site as soon as people access it, rename the frames page with the file name default.htm.

Using Stylesheets
FrontPage 98 supports 100 percent round tripping of all CSS attributes and also provides an interface for setting CSS properties. To create inline styles, simply highlight the text you wish to format and select Format/Paragraph/Styles from the FrontPage Editor.

The next section shows you how to create a simple style block. Let’s suppose you want a page set up so it uses the Courier New font as a default, and the default text color is to be maroon (in other words, the <BODY> tag is to have these style attributes). Furthermore, you want all H1 level headings to be in black Arial, bold italic; and all paragraphs are to have a left margin of 16 pixels.
To create this style block on the active page, do the following:

1. Go to the Format menu and select Stylesheet. This opens the Format Stylesheet dialog box. In the dialog work space, place the insertion point right after the <!-- marker, and press ENTER to get yourself some working room, as shown in Figure 43:

![Figure 43](image1)

2. Begin by setting up the default appearance. Type “body,” then a space (the space isn’t strictly necessary, it’s just for readability). Then click the Style button at the lower left of the dialog box. This opens the Style dialog box.

3. In the Style dialog box, click the Font tab. In the scrolling list box under the Primary Font text box, scroll until you find Courier New, and select it. Don’t click OK yet (see Figure 44).

![Figure 44](image2)

4. Click the Colors tab. In the Foreground Color list box, find and select Maroon.

5. Now click OK. When you return to the Format Font dialog box, you’ll see that the style code now reads “body {font-family: Courier New; color: rgb(128,0,0);}.”

That sets up the page font and color defaults. Now we need to set the heading characteristics, as follows:

1. Still in the Format Style dialog box, put the insertion point at the end of the body line and press ENTER to get a blank line below it.

2. Type H1, then a space.
3. Click the Style button. In the Style dialog box, click the Font Tab, and use the Font sheet to select Arial.

4. Click the Text tab to open the Text sheet. In the Weight text box, scroll to find Bold, and select it. In the Style box, scroll to find Italic, and select it (see Figure 45).

![Figure 45]

5. Click OK to return to the Format Stylesheet dialog box. You’ll see this line added to your style block: “H1 {font-family: Arial; font-weight: bold; font-style:

Now set up the paragraph format:

1. Use Enter to make a new blank line under the one you just created. Type P, then a space, then click the Style button.
2. Click the Alignment tab. In the text box labeled Left, type 16.
3. Click OK to return to the Format Stylesheet dialog box. You’ll see this line added to the style block: P {margin-left: 16;}.

Now you’re finished, so click OK in the Format Stylesheet dialog box to return to the FrontPage Editor work space. Type an H1 level heading and some Normal text; they should appear as you specified in the style sheet.

Adding DHTML: Collapsible Outlines

In FrontPage 98, the collapsible outline is built around lists, either bulleted or numbered. Begin by setting up a list with at least one sublist (a nested list). Then place the insertion point in any list item in the topmost list, and choose Format/Bullets/Numbering. When the List Properties dialog box appears, mark the Enable Collapsible Outlines checkbox (see Figure 46):
This means that the list(s) subordinate to any element in this list will vanish or appear as the element is clicked. Note that each list that is to have collapsible sublists must be marked as collapsible in the List Properties dialog box — in other words, enabling collapsible outlines for one list does not automatically enable them for the list levels below or above it.

Let’s assume that you’ve created the bulleted list shown in Figure 46, and you’ve enabled collapsible outlines for the headings of the top level. When you open the page in Internet Explorer, the entire list will be visible (this is to allow for non-DHTML browsers). Click any top-level heading, and the second-level headings below it vanish. Click it again, and they reappear.

Adding DHTML: Page Transitions

As we move away from bare-bones Web page presentations, the creative itch can grow stronger in Web authors. Why, for example, should pages just appear? Why shouldn’t an author be able to do neat things with transitions, the way he or she can with slide transitions in PowerPoint? Now it can be done easily in FrontPage 98.

Begin by opening the page where you want to apply the transition. Then choose Format/Page Transition to open the Page Transitions dialog box (see Figure 47):
You have more than 20 possible transitions to apply to a page entry or exit or to a site entry or exit.

In the Event drop-down list box, specify whether you want the effect to take place on Page Entry or Exit, or Site Entry or Exit. Then, in the Transition Effect list box, select the particular transition you want, and in the Duration text box type the number of seconds over which the effect is to take place. You can apply two different effects to the same page, one for entry and one for exit. The Exit effect takes place as the page vanishes from the user’s browser, and the Entry effect as it appears. The Site Entry and Site Exit options create the effect when the user enters or exits the Web site via the page to which the effects have been applied.

Adding DHTML: Animation

In this case the page element itself is not animated, its entry onto the page is what’s lively. All you do to invoke the effect is select the text or image you want to animate. Then choose Format/Animations to open the Animation submenu, as shown in Figure 48:

![Animation Submenu]

The first eight animations are straightforward linear animation. The By Word animations make text appear a whole word at a time, falling in from various directions. Spiral is a curved path, like the corresponding effect in PowerPoint. The Zoom animations are based on changing the size of the element as well as the animation path.

Select the effect you want, and the menus close. Then use Preview or the Preview in Browser command to test the behavior of the effect. To remove the animation, select the animated element, choose Format/Animations, and select Off from the menu.

System Requirements

To use Microsoft FrontPage 98, the following components are required:

- Personal or multimedia computer with a 486 or higher processor
- Microsoft Windows 95 operating system or later, Microsoft Windows NT Workstation operating system 4.0 or later, or Microsoft Windows NT Server 4.0 or later. (FrontPage 98 will not run on earlier versions.)
16 MB of RAM for use on Windows 95; 32 MB of RAM for use on Windows NT
36 MB of available hard disk space
CD-ROM drive
VGA or higher-resolution video adapter (Super VGA, 256-color display recommended)
Microsoft Mouse, Microsoft IntelliMouse™, or compatible pointing device
Internet access is necessary to use Internet features; Internet and other online access may require payment of a separate fee to a service provider

The following are additional hard disk requirements for included tools:
11 MB for Microsoft Internet Explorer 4.0
1 MB for Microsoft Personal Web Server for Windows 95
10 MB for Microsoft Peer Web Services for Windows NT Workstation
1 MB for Web Publishing Wizard
2 MB for Internet Mail and News

To use Microsoft Image Composer, the following components are required:
486/66 MHz processor or higher (Pentium processor recommended)
16 MB of RAM (32 MB recommended)
Hard disk space: 28 MB minimum; 44 MB typical, depending on configuration
VGA, 640x480 16-bit color (Super VGA, 800x600 24-bit TrueColor with 2 MB of video memory recommended)

The following are optional for Microsoft Image Composer:
Windows-compatible tablet with mouse emulation for basic mouse support, or
WinTab-compatible tablet for Full Pressure support
TWAIN-compatible scanners or digital cameras

Microsoft, FrontPage, ActiveX, Windows, Windows NT, WebBot, PowerPoint,
Visual Basic, Outlook, Visual SourceSafe, Visual InterDev and IntelliMouse are either registered trademarks or trademarks of Microsoft Corp. in the United States and/or other countries.
Java is a trademark of Sun Microsystems Inc.
Other product and company names herein may be trademarks of their respective owners.

The information contained in this document represents the current view of Microsoft Corp. on the issues discussed as of the date of publication. Because Microsoft must respond to changing market conditions, it should not be interpreted to be a commitment on the part of Microsoft, and Microsoft cannot guarantee the accuracy of any information presented after the date of publication.

This document is for informational purposes only. MICROSOFT MAKES NO WARRANTIES, EXPRESS OR IMPLIED, IN THIS DOCUMENT.